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Thank you very much for selecting TK8 Backup! 
 
TK8 Backup is an easy-to-use tool with features like efficient
compression and security, off-site FTP backups, CD and DVD
burning, built in restoring wizard, etc. Scheduling and unique folder
monitoring system ensures you always have the latest version of
your important files. 
 
Most about TK8 Backup is described in this manual. Just locate to
the topic you are interested in. 
 
If you have any questions, suggestions or comments, please
contacts us.
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1 TK8 Backup

1.1 Program Description

  
TK8 Backup is reliable, easy-to-use backup software to ensure you never lose your important files. 
It will protect your data from loss like file corruptions due to computer crashes, hard disc failures,
human errors, theft, virus attacks, etc.

If you care about your information, you should use TK8 Backup.

Making backups of files and folders is fast and easy. Imagine how useful it would be to have your
documents, Address book, Favorites and Outlook or Outlook Express data all backed up daily.
Never lose another email by accidentally deleting it.

By setting up different backup tasks you will have a flexible backup system. Each task can have its
own settings like which files to back up, how often, how many of your previous backups to keep,
where to keep them, etc.

Besides full backups, incremental backups can also be created. With incremental backups only
changed or added files will be backed up, compared to the last backup. This means smaller backup
files and saved disc space.

To save your disc space, all backups are compressed automatically. The popular ZIP compression
used is fast and efficient. For example, some text documents can be compressed more than 90%.

Backups can be password protected and encrypted. One of the most secure encryption algorithms
is used to secure your data (256 bit Rijandael). So you never have to worry about unauthorized
access to your information. 

Backups can be saved to your hard disc, local network drives, CD, DVD, USB discs, Zip drives,
Jazz drives, MO drives, etc. If your backup is too large enough to fit one disc, TK8 Backup can split
it and save it on multiple discs. Even duplicate locations can be set up to keep your data in different
places.

You also have the option to automatically upload your backup ZIP files to an off-site server using the
built in FTP client, so that the information is available should a fire or burglar destroy your computer.

Once backup tasks are set up, you can make backups with a single mouse click. You can also use
the scheduler, so backups would be created automatically on hourly, daily or monthly basis. By
using scheduler, you don't have to worry about forgetting to back up your data. Different options and
unique folder monitoring system ensures you always have the latest version of your important files. 

Not only making but also managing your backups is important. As you can have separate backup
versions of your data, it is important to see how much space they are taking, where are they
located, which files they contain, etc. You might also want to burn additional copy to another CD or
DVD. For all this, recent backups list is always seen on the main screen, allowing you to easily
manage backups of the selected task.

Built in Restoring Wizard is the tool that makes restoring your data easy. To get your data restored,
just follow the steps. Quick restoring option allows you to restore the whole backup without any



TK8 Backup

- 4 -

wizard questions.

TK8 Backup can also create self-extracting backups. In addition to your data, the executable
backup file also contains the restoring wizard. So you do not need any other program to restore your
data. Just execute the backup file and follow the wizard steps.

Advanced users can use many additional features and options like filtering source files, backing up
open files, unlimited backup file size, backup process logging, email notifications, processor usage
limits, system tray mode, hidden mode, integrated CD and DVD burning tool, easy FTP
management utility, etc.

How would you cope with losing all of your documents and data files due to theft or hard
disk failure? 
 
Let TK8 make backups for you; so you never have to worry about losing data again! 
 
 
Minimum System Requirements:
Windows 98, NT4, ME, 2000, XP Home, XP Pro, 2003 Server, Vista;
400 MHz or better Pentium® processor or equivalent;
about 10 MB of free disc space;
 
  

1.2 Program Features

Top 5 features current users love most:
1) Easy and flexible scheduling options
2) Integrated Outlook Express, Favorites and Address Book backups
3) Built in CD / DVD burning and FTP uploading
4) System tray and silent backup mode
5) Possibility to back up open files

Feature Highlights: 

· Easy to understand and fast user interface. 
· Tutorials and documentation to get you started quickly. 

· Include any type of local folders and files, or information over the local area network (including
password protected and/or disconnected network drives) 

· Integrated Outlook Express backups (all identities, including e-mails, attachments, mail rules,
accounts info etc.) 

· Integrated Outlook backups (including e-mails, e-mail accounts, contacts, calendar, tasks,
etc.) 

· Integrated Address Book backups 
· Integrated Favorites backups 
· Integrated My Documents backups 
· Integrated Desktop backups 
· Integrated Windows Fonts backups 
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· Open files are included to the backup also. 
 

· Unlimited backup tasks with different settings and source folders 
· Advanced filtering options to include and exclude files based on type, name, size and other

options 
· 6 different backup types supported: Full, Incremental (from modified files only), Differential,

Inverse, Incremental combined with full backups, Differential combined with full backups 
· Popular ZIP file format used to keep the backups efficiently compressed. 
· Possibility to disable zip compression and do the plain copy. 
· Backup files with different timestamp and versions. 
· Ability to limit how many recent backups should the program keep 
· Executable backup files with integrated restoring wizard. 
· Windows Service support that can run backup tasks even when nobody is logged in. 

· Password protection of backup files 
· Additional backup encryption available (AES 256) 

· Log files with different options 
· E-mailing log files 

· Unlimited backup file size 
· Backup splitting options 

· Built in scheduler with different options and folder monitoring. 

· Save your backups to hard disks, network drives, Zip drives, Jazz drives, MO drives, floppy
disks, USB and FireWire portable drives, etc. 

· Integrated CD-R, CD-RW, DVD-R, DVD-RW burning, including multi sessions. 
· Integrated FTP uploading 
· Send backups to e-mail address. 
· Easy CD / DVD burning tool with disc maintenance options. 
· Easy FTP management tool 

· List of recent backups for every backup task

· Integrated restoring wizard 
· Integrated quick restoring option 

· System tray mode 
· Hidden and password protected working mode 
· Run other programs before and after the backup is created 
· Option to shut down the computer after the backup was created 
· Option to make backups automatically right before the computer is shut down 
· Desktop shortcuts to start different tasks 
· ZIP compression level settings 
· CPU usage limits 
· Customizable look 

· Many additional options for advanced users 

· Windows XP user interface look support 
· Multi language support 
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1.3 How To Start

After the program is installed, you can start TK8 Backup in several ways:

1) In the Windows Start menu, select Programs, TK8 Backup folder, and click on the TK8 Backup
icon. 

2) If the TK8 Backup icon is on the desktop, you can run the shortcut with double-clicking on it.

3) TK8 Backup can be started automatically on Windows startup. You can read more about this in
the General Options chapter.
 
 

1.4 Main Window

TK8 Backup has an easy to understand user interface you can see below:

You can use a menu and toolbar buttons (1) to access different commands and utilities built in to
the program. Backup tasks, which are work descriptions for the program, can be seen on the task
list (2). To add or edit tasks, use the toolbar button or the Tasks menu. Recent backups for the
selected task can be seen on the bottom panel (3). 
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In addition, you can right-click with your mouse on the task and recent backups list to open different
kind of pop up menus for quick actions.

Changing column position and size

Task list has default widths and positions for every column. But this can be changed. To change the
size of a column, move the mouse cursor to the end of the column header name, until a cursor takes
a sizing shape. Then click the left mouse button, hold it down and move the mouse to left or to right
until you get the column width you want. Then release a mouse button.

To change the position of some column, left click on the column header and hold the button down.
Then move the column to the position you want and release a button.
 
 
Sorting tasks

To sort tasks in the list by some column, just click on the column header. A rectangle appears
showing the sort order. The second click on the already sorted column header will reverse the
sorting order. So it is possible to sort tasks ascending or descending, depending how you would like
to see the list.

It is also possible to sort the list by more than one column. To add sorting to additional columns,
hold down the SHIFT key on the keyboard when clicking on the additional column header. 

Quick search

If you have a lot of tasks, then to find some of them quickly, just start typing on your keyboard and
the closest match is located immediately. The locate is made by the column with currently selected
cell. 
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2 Backup Tasks

2.1 What is a backup tasks

Backup task is a job description to the program. It shows what information, when, and to where you
would like to back up.
 
You can create different backup tasks so that managing your backups would be easier. For
example, you might want to make backups from your e-mails every day but only once per week from
other documents. Having different backup tasks allows you to use different schedules and other
options when backing up your information.
 
Also, in most cases having many smaller backups (tasks) is better than one large backup (task) of
your data. Usually restoring smaller backups is easier and faster, should you need some or all files
from your backup. The same applies to creating large files - usually creating many smaller backups
is faster than one large backup.
 
Backup tasks can be added and edited by using the toolbar buttons or the Edit menu.
 
 

2.2 Task name & type

When adding or editing backup tasks, the task details window is opened. The first active panel on
that form is always the "Task Name & Type". 



TK8 Backup User's Manual

- 9 -

 
After giving a descriptive name to your backup task, you can select the backup type. 
 
The program can make different kind of backups:

1. Full Backup. With full backups all files (from folders you have pointed out) are included to the
backup. In case you need to restore your data, you will find everything in one backup file.

2. Incremental backup. With incremental backups, only modified or added files are backed up,
compared to the last backup. When making incremental backups, you end up with a lot of
small backup files. To restore some particular file, you have to find the latest backup of that
file. To restore everything, you have to restore the first backup, then the second backup, then
the third backup, etc... It can be time consuming work if you change your files often. The
advantage of incremental backups is that it takes much less time to make an incremental
backup (as usually you change only some files), and backup files will take less room on your
storage media (Hard drive, CD or DVD).

3. Incremental + Full. This backup type removes the inconvenience of incremental backups. It
will make a number (set in this same panel) of incremental backups, and after that a full
backup. After the full backup is created, the incremental backup is created next time again.
When restoring your data, you will have to restore the full backup, and only few smaller
incremental backups. At the same time, making incremental backups is fast and they take
much less room compared to full backups.

4. Differential backup. With differential backups, only modified and added files are backed up,
compared to the last full backup. Similar to incremental backups, the backups are smaller
and faster to create. To restore everything (or a single file), you have to restore only 2 files -
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the first (full) backup (containing all your files) and the latest (differential) backup.
5. Differential + Full. This backup type will make a number (set on this same panel) of

differential backups and then a full backup. Creating full backup from time to time is useful as
when time goes by, the number of files that are changed since the first backup increases. So
does the time it takes to make the differential backup and the size it has. That's why it is
important to make full backups from time to time. If you make a full backup each week, the
backup size and the time it takes to create it is probably much smaller than for the differential
backup where the last full backup was created months ago. 

7. Inverse. Inverse backup type will back up files that are unchanged since the last backup.
 
 
Next you can do on this panel is to limit the number of recent backups from this task. This
option is available only for full backups and types combined with full backups. Once this limit is
reached, older backups are deleted automatically. That way you can be sure you will not run out of
free disk space. And at the same time, you have a number of recent versions from your valuable
work. If you want to keep all the backups, just uncheck this option. This setting affects also files on
the FTP server (if uploading is activated), but not CD and DVD discs. CD and DVD discs are not
affected as in most cases files can not be deleted from discs once they are burned.
 
The program can also make an executable backup file. In that case, the backup file isn't a ZIP
archive file, but application file that you can execute like any other program. It contains both your
data that was backed up, and the integrated Restoring Wizard. So to restore your data, you don't
need to anything except the backup file itself (you don't need even TK8 Backup itself). You can run
the file, and restore the data you need. To make your backups executable, check the option on this
panel. 
 
There are some drawbacks using executable backups, though. The most important is that as
the file is an application file, it is much more open to file corruptions and virus attacks than other
"normal" archived files. It is possible that your backup (in this case application) is corrupted for the
time you need to restore your data. If that happens, you can't execute the file and accessing your
data is impossible. If the backup would be a normal archive (zip file), there are ways to fix ZIP
archives, even if something should corrupt them. Another problem with executable backups is that if
the backup file is large, then to run this application, it has to be loaded into your computer memory.
If you don't have enough memory (at least as much as large is the backup), restoring such backups
can be time consuming. So you have to calculate the risk before making executable backups. 
 
You can use additional option for full backups. If you don't want to create another backup file from
your data if the data isn't changed since the last backup, just activate the option "Make only if
there are changed or new files compared to the last backup".
 
In the Professional version you can additionally select the group for the current backup task (if
groups are activated from the Program Options). Grouping can be useful if you have a lot of backup
tasks to manage. To select a group for your task, just select it from the drop-down list. To add or
edit available group names, click the "Edit list" button at right of the drop-down list.
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2.3 Data to back up

 
The second panel on the task details window is "Data to back up". On this panel you can select the
sources you would like to back up with this task. 
 

 
Backing up folders from local computer

At left on this panel you can see the folder tree (structure) of your computer. To expand the folder
and see its sub folder, click on the "+" button in front of the folder. To collapse, click on the "-"
button. To include some of the folders to the backup, just find the folder and activate the check box
in front of it. Folders having a green check mark on the box are included to the backup.
 
Your backup task can have as many folders selected as you like. In most cases, though, it is better
to create different tasks for different folders and data. That way each task (and backup file) would
contain only a particular type of data. For example you could have one backup task for your
Documents, another for emails, and third for your photos. That way managing your backups is much
easier, and restoring faster, should you need to restore some or even all of your data.
 
By default, all folders (including hidden folders) are shown in the folder selection list. It is important
that you won't miss any folder, even if it's hidden, when selecting what data to back up. If for some
reason you do not want to see hidden folders in the selection list, you can turn off this feature from
the program options, Advanced settings panel.
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Selecting a single files to the backup task

To back up some particular file, you have to first activate the panel "Local Files" at the left bottom of
this screen. On the similar panel you can then look up the file and select it to be included to the
backup. 
  
  
Shortcuts
 
At right, you can check "shortcuts", to back up resources otherwise not available in the folder tree:

 
· Microsoft Outlook. If this shortcut is selected, the program includes all your default Outlook

data automatically to the backup. This includes all e-mails and settings (including folder tree,
accounts, rules, calendar, contacts, tasks etc.). Please note - if you have changed the data
file locations in Outlook settings, your data can be located in different or additional locations. In
that case, please select those folders additionally to the backup task, as "Outlook data" option
will only include the data from default locations. Also, please note that Outlook has to be closed
when making a backup. Though TK8 Backup will close your Outlook automatically before
backing up the data, you have to close other programs accessing your Outlook data (if you have
any).

· Outlook Express. If this shortcut is selected, the program includes all your Outlook Express
data automatically to the backup. This includes all e-mails and settings (including folder tree,
accounts, mail rules, blocked senders etc.)

· Favorites. If selected, includes favorites data automatically when creating a backup from this
backup task.

· Windows Address Book. If selected, the program includes your Address Book when creating
a backup from this task.

· Windows Fonts. If selected, it includes Windows Fonts folder to the backup file when this task
is executed.

  
 
Backing up data from network computers
 
To back up folders from other computers over a network, click on the "Network Computer" panel
name. That will open a similar folder tree, where you can use standard network computer location
tree, and select the folder shared on the network computer(s).
 
If the network computer requires a user name and a password to access files, you can enter those
below the folder tree (available in the Professional version only). In case you log off, and/or the
network drive is disconnected by Windows, this user name and password allows the computer to re-
establish the connection with that network computer, if necessary.
 
 
File rules 

By default, all the files from selected folders are backed up when the task is executed. But if
needed, you can exclude some (or include only) specific files, based on the type, size or age. 
 
To see or edit current file rules, click on the "File rules" panel name at the bottom of the current
(Data to back up) panel.
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When you edit or add a new rule, the rule window is opened:
 

The first option you can set to the rule is a file type filter. It can be either the inclusion or exclusion
rule. Inclusion rule can be useful if you want to back up only MS Word documents, for example. In
that case, delete the default "Include all files" rule and add a new rule: "Include *.doc". You can add
additional inclusion rules to the backup task if you need. For example "Include *.xls" will include all
your Excel documents. 
 
If you want to exclude some files based on the file type, don't modify the default "Include all files"
rule. Just add a new rule, where you point out what you would like to exclude from your backup.
Similar to the inclusion rules, you can have more than one rule for each backup task.
 
If you need to filter files based on their size and age, you can do so in the Professional version. It is
possible to include or exclude files if they're smaller, greater, or between some size (or date).
   
 



Backup Tasks

- 14 -

2.4 Backup destination

Next step in setting up the backup task is to select where you would like to keep your backups.

If you would like to change the default location (folder) where the backups are stored, click on the
"Select" button and locate the folder you would like to use to your keep backups of this task. This
will be the destination folder for your backups. Please note that destination folder should be a
folder in your local or network computer, on the hard drive. Destination folder can not be
your CD or DVD device. To put your backups to CD and DVD discs you can use other options
explained below. 
 
After the destination folder is set, you can select the name template. It is used to give a name to
each backup file that is created. Available options are:

1. task name.zip
2. task name \ year - month - day, time.zip
3. task name \ year \ month - day, time.zip
4. task name \ year \ month \ day, time.zip
5. task name year - month - day, time.zip
6. taskname-year-month-day-time.zip
7. year - month - day time.zip
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"Task name" in the template is replaced with real task name when the backup is created. Other
values like year, month, day and time are replaced with backup file date and time. When using
templates 2, 3, or 4, also appropriate sub folders are created to the destination folder. Template 6 is
different in terms that spaces are removed from the backup file name (required to upload backups to
some Unix FTP servers).
 

After the backup is created

Once the backup file is created, you have some additional options available:

1. Burn. If you have CD or DVD burner installed to your computer, and set up in the program
options, you can burn the backup to the disc automatically. Just check this option and make
sure the disc is in the drive when the backup is created. If the disc is not in the drive, the
backup is still created, but it can not be burned. 

3. Upload to FTP. If you have FTP server access, you can upload the backup file to the remote
computer. For this, check the FTP uploading option and click on the "FTP settings" button.
On the FTP settings dialog, enter the information about your server:

· Host is the address of your remote FTP server. 
· Port is the port used by your FTP server (by default, 21)
· User name is the name used to connect you to the server
· Password is the password used to connect you to the server
· Folder is the default folder the program will open once you are logged in.
· Passive mode selection indicates if the servers using the passive mode or not.

3. Copy to additional location option, if checked can duplicate the backup file and copy it to
additional location in your local or network computer. 

4. Delete from the destination folder after burned / uploaded successfully option can be
used to delete the backup file once it is burned and / or uploaded successfully.

 

2.5 Schedule

You can always make backups manually. For this just click on the "Start Backup" button on the
main screen toolbar. But the program can also make the backups automatically. For this, you have
to set up a schedule on the Schedule panel:
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To auto start a task, you have to decide which kind of scheduler type you would like to use:

1. No Schedule

When you add a new task, it has no schedule set by default. To make a backup from the task
like this you have to start the task manually, at the time you need or want. It's useful in cases
you don't know exactly when you would like to make your backups.

2. Run on particular weekdays.

If you want to make a backup on particular weekdays, at the same time, you can use this
scheduling option. After selected, you can set the backup start time, and the days it should be
done. For example, you can set to make backups from this task at 3 AM on each Wednesday
and Friday, when the computer is idle anyway... 

3. Auto start when some file in the source folders has been added or changed. 

If set, your selected folders are monitored and the backup is started soon any change is
detected in these folders (like a file is added, changed or deleted). 

You can also set the delay time of how long the program should wait before starting the backup.
Delay time allows you to finish the work before the backup is started. For example if you save



TK8 Backup User's Manual

- 17 -

the document, the program detects a change and wants to make a backup immediately. But it
might be that you are not finished yet and so the program starts the delay time countdown. If
you change the file during that time, the countdown is restarted. Once you have completed the
work with your file, and program detects that during the delay time countdown no more changes
has been made in the selected folders, the backup is created.

 
4. Recurring schedule.

Another scheduling option available is recurring schedule. It will auto start the backup after the
time set is passed by from the last backup. For example, you can set that the backup should
be made after each 6 hours. Additionally, you will see when the next backup is started based
on the current settings.

 
 
Missed schedules

When the computer is turned off at the time the backup should be started, it is not possible to
create a backup. The backup is then done right next time when the computer and the program are
started. If you don't want to auto start missed backups on program startup, you can disable this in
the Program Settings.
 
 

2.6 Advanced task settings

2.6.1 General options

 
For advanced users, there are many additional options available in the Advanced panel. The first
Advanced sub-panel is "General options". It will look like the following:
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Save full path information
 
By default checked, the full path of the folder is added to the backup, including the root folders. 

If you have selected to back up "Third folder", and the full path of this folder is „C:\First folder\Second
folder\Third folder", then without this option checked, your backup file contains files and sub folders
of „Third folder" only. In the backup file there will be no information about „First folder" and "Second
folder". If you restore this backup, you have to specify the folder where the files and sub folders will
be restored to. 
 
If the option is checked, the full path information will be stored, including the folders „First folder" and
"Second folder", though you only selected "Third folder" to be included. Please note, that this will
store only the structure of root folders and not their files nor other sub folders. If you restore this
backup, you have to select just the drive root where you would like to restore the backup (in this
case „C:\"). All the files will be restored to their original locations then.

Split the backup
 
If the backup file is too large, you can split the file. For example, if the backup is 3 GB in size and
you would like to burn it to the CD, then it just doesn't fit there. Though the file size is OK for DVD
discs, its not acceptable if you want to burn the backup to CD discs. In this case, you can set this
option to split the file and enter the maximum part size in megabytes (for example, 700 MB). 
 

Disable ZIP compression
 
Selected folders can also be copied without compressing them to the ZIP file. This way you can
keep a full duplication of your data on another location.
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Hide backup progress window
 
This option is available in the Professional version only. When checked, you will not see the backup
progress window at the time the backup is created. The program will make the backup from this task
silently.

Compression level
 
Compression level for each backup task can be changed also. As "Normal compression" is optimal
for most cases, it is set to default. If you have powerful computer and you prefer having the smallest
backups in size, you can switch this option to "Max compression", though creating these backups
will take more time and requires more processor usage. "Fast compression" can be useful if you are
backing up photos. Photos are already compressed in most cases and so the normal or max
compression takes just too much time analyzing and compressing them with little effect.  If you
select "No compression", then files are still in the zip file, but they are uncompressed there. The
difference with disabling zip compression is that with "no compression" all your data is in one file,
thus it is easier to manage it (copy, burn, etc)..
 
Backup process priority
 
This option is available in the Professional version only. It allows you to select Windows based
priorities for CPU-usage in making backups from this task. The default priority is Normal, meaning
the task has no special resource needs and the processor power is divided equally between other
programs. Low priority means that the backup process will only use the resources other programs
are not using. High priority is time-critical task for Windows and means that all possible power of the
CPU is available for this process and all other programs will get less resources.
 
Make the backup on program startup
 
If this option is checked, the program will make a backup from this task every time the program is
started.
 
Make the backup right before
 
This option is available in the Professional version only. When checked, the program will make a
backup automatically each time the computer is turned off, logged off, or switched to the stand-by
mode. Soon the program detects any Windows closing, it will pause that and perform the backup.
After the backup is done, the program resumes the Windows closing.
 
Turn off the computer after the backup is completed
 
This option is available in the Professional version only. It allows you to turn off the computer after
the backup of this task is created. Of course, when you have other backup tasks scheduled, those
schedules can't be started. So it's important to enable this option only for the task you are
performing the last.
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2.6.2 Log file / E-mail

 
To get information about the backup process, the log file can be created:

Log file is a document containing details about the backup file and its creation process. It is saved
with the same name template as the backup file itself, except it has the file type of text file (txt). Log
file includes header information like source folders, file rules, and also errors if some occurred during
the backup process.  Errors are also reported if the program was unable to include some file (for
example if it was deleted or you have set to exclude open files and the file is open at the time
backup was created). Log files also have footer information like destination path of backup, files
compressed and the final backup size.
 
Since the version 3.1 it is possible to log each file added to the backup. For this, activate th option
"Include file names backed up". In this way you can see exactly what files were added and search
for a particular file from inside the log file to see if it is in that particular file or not. It's useful specially
for incremental backups when you do not know exactly which backup contained the file you are
looking for. 
 
In the Professional version, log files can also be e-mailed automatically after they are created.
Additionally, you can send the email only in cases some errors were found during the backup, and
include the backup file itself as an attachment. Please note that large attachments are in most
cases rejected by mail servers. 
 
If you need, you can send the email to multiple addresses, by entering the addresses and
separating them by comma. 
  
If you are using any emailing options, please make sure the mail server information is set up in the
Program Options, Email panel. You need to specify your outgoing e-mail server (host) at least. in
general you have to use the same server and account information you are using with your email



TK8 Backup User's Manual

- 21 -

program. If this information is unset, it is not possible to send out emails.
 
 

2.6.3 Security

 
On the security panel, you can protect your backup with password:

By default, backups are not protected. 
 
If you want you can select the type of protection and enter the password. 
 
Simple password protection (the second option in the list) is good as it is the zip file standard and
the file can be opened with all zip compatible archiving programs if you know the password. For
strangers, the files inside the backup are still not accessible without the right password. They can
see the file list, but accessing any file inside the file is impossible without knowing the password.
 
In the professional version, you can use additional "real" file encryption in top of the standard
password protection. Please note, that this backup file can only be opened with TK8 Backup
Restoring Wizard and the password is required for this. 
 

About the security
 
If you should lose the password, then standard password protected files can be cracked. For this
there are programs available and though it can take months to crack a file, you still have the
possibility to access the files if you should forget the password. It has a downside, but the good
thing is also that should you really forget your password, your data is not lost forever...
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If the backup file is encrypted, there is no possibility to open it without the correct password. TK8
Backup uses one of the strongest Rijandael 256-bit encryption algorithm which is practically
impossible to crack within hundreds of years. This is secure, of course, but also dangerous
protection method should you lose the password. 
 
The only way to restore Rijandael (AES 256) encrypted backup is to decrypt it at first with included
decryption tool.
 
Login information to access target path

In the Professional version, you can enter here the user name and the password for the destination
folder if it is using any authorization. If the network drive is disconnected by Windows, the program
can re-connect it automatically using this information. 
  
 

2.6.4 Other programs

 
If you want you can use other programs to perform additional actions before and after the backup is
created:

 
To use some other program or macro, you have to check whether you want to use it before or after
the backup is created. After you check one (or both) of those options, you can click on the "..."
button on the edit field and locate the application or script you would like to use.
 
If the application is set to run before, you can enter how many seconds the program should wait
between the application and backup itself is started. After the application is started, and delay time
passed by (if set), the program will start making the backup from the current task.
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You also have the option to terminate any process before the backup is started. For this, enter the
process name (for example outlook.exe) to the edit box with the label "Terminate the following
process before running the backup:". If there is a need, you can enter multiple processes to this
field, separated by comma.
 
In addition, you can enter the number of seconds you would like to wait between the process is
terminated and the backup started.
 
 

2.7 Importing and exporting tasks

 
By using the File menu, you can export and import your backup tasks and related information like
recent backups lists, ftp settings etc. Exporting is useful in case you need to transport your program
from one computer to another. Or, you can use export command to make a backup of your task and
program settings. 
 
Please note that when importing tasks, your current task list and program settings are replaced with
information found in the import file.
  
 

3 Creating and managing backups

3.1 How to create backups

 
Once you have set up backup tasks, you can start making backups. Backups can be created
automatically if you have set up scheduling. But if you want, you can create backups manually at
any time. 
 
To start a backup task manually, select the task and click on the "Start Backup" button on the
toolbar, or open the Tasks menu and do the selection there. When you click on the right part (small
rectangle) of the toolbar button you can additionally select if you want to add a comment to your
backup file or not. With default program settings it is also possible to start the backup by double
clicking on the task. 
 
Since the version 3.2 you can also make a shortcut to your desktop, for each task. You can do this
by using the Edit menu. No matter if the program is closed or not, whenever you double click on the
task icon, the backup is created for that task.
  
Backup can also be started by using the keyboard shortcuts. Press F9 to start creating a backup,
and F10 if you want to add a comment for the backup file.
 
When the backup is in progress, source folders are scanned and the files included to the backup.
The backup is then saved to the destination folder, and uploaded and/or burned, if set so. 
 
Soon the backup task is started, you will also see the progress window with status about the
backup, including the time elapsed and estimated time left to complete this backup job:
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If you are using backup grouping then by opening the pop up menu of "Start Backup" button (the
right part of the button) you can start the backups for all the tasks from current active backup group.
Additionally, if the task type is incremental backup, you can select from that menu to make a full
backup from this incremental backup task. 
 
You should know, that backups are auto started based on the schedule only when the user is
logged on. If the computer is turned off, hibernated, or the user is logged off, the program can't auto
start backup tasks. To make backups at night, please disable auto log-off. For security reasons, you
might want to enable also password protected screen saver that will prevent unauthorized access to
your computer in case you are away for some time. In the Professional version, there is a Service
Utility available, though, that can run your backup tasks even when nobody is logged on to the
computer. You can read more about the Windows service support in the chapter "Utilities, Windows
Service Manager".
 
 

3.2 Managing Backups

 
All the backups of selected backup task are seen on the recent backups list. 

Once the backup is created, it is listed in the recent backups list and you have several options
available what to do with that file. 
  
You can access the commands below from the Tasks menu, or by clicking the Recent backups
menu button on top of the recent backups list:
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1. Open will start your default ZIP archiving program and opens the selected backup file with it. 
2. View log file allows you the quick access to the log file (if you have set to create a log file

along with the backup). 
3. Restore and quick restore are explained in the Restoring Backups chapter.
4. Burn command is useful if you do not want to burn the backups automatically after they are

created. Instead, you can burn them later by using this command
5. Upload connects to the server set up in the backup task and uploads the selected file to the

remote FTP server. Similar to burning, this can be done automatically after the backup is
created, but for users preferring to do this manually, this command is available.

6. Delete can be used if you do not need some backup file any more. 
7. Refresh command in the recent backups menu leaves only those backups to the list that are

found at the time refresh is done. If you have deleted some backup files outside the TK8
Backup program, with Windows Explorer for example, then refresh command removes those
backup lines from the list, as they are not on your destination folder any more.

 
  

3.3 Restoring Backups

 
You can start the restoring process not only by running the Restoring Wizard from the Utilities
menu, but also by using the Tasks menu or by using the Recent backups menu commands. 
 
The only difference compared to other starting methods is that when you run the Restoring Wizard
from the Utilities menu, you have to locate the backup file you want to restore. When started from
the menus, the backup file is already selected based on the active task or recent backup selection.
Thus in many cases it's more convenient to run the Restoring Wizard from the recent backups
menu. 
 
Quick restoring option in the menu is similar to the description above, except it starts restoring
process automatically, and you do not have to do any selections in the wizard. All the files found in
the backup, are restored to their original locations. Current files available are replaced with the ones
found in the backup.
 
If you have created an "executable backup", you do not need any other programs (including TK8
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Backup) to restore your data. You only have to execute the backup file from Windows (through My
computer, for example, and follow the restoring wizard steps.
 
You can read more about restoring process and steps from the chapter "Utilities, Restoring
Wizard". 
 
 

4 Utilities

4.1 System Tray Mode

 
TK8 Backup has possibility to run in the system tray mode. In system tray, it continues running and
making scheduled backups just as in normal mode. The program is hidden from the Windows task
bar and accessible when you click on its icon on the system tray area, near to the system clock:
 

 
You can go to the system tray mode by using the Tools menu or pressing F12 on your keyboard.
Also, if set in options, TK8 Backup can go to tray mode automatically after started.
 
When you click on TK8 Backup tray icon, the menu appears where you can start different backups
of your tasks. Backups can be started with or without comment:
 

 
To restore the normal main window mode (for example to add or edit tasks), click on the icon and
select "Open TK8 Backup" from the appearing menu. Also, you can press system wide hotkey on
your keyboard (by default Ctrl + Alt + B).
 
 

4.2 Restoring Wizard

 
Restoring Wizard is the tool to easily restore your backups. Advanced users can also extract
backups manually and put the files back to their original location. If that's too complicated, you can
use the Restoring Wizard that will help you on this. Additionally, Restoring Wizard is useful even for
advanced users when restoring "shortcuts" like backups containing Outlook Express and Favorites. 
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As you can see at the restoring wizard left panel, restoring a backup requires four steps to be
completed:

1. Opening backup file is the first step, where you can select the backup file for restoring.
Just locate the backup file you want to restore and click on it. After that, you can click the
Next button. This step is skipped (file is selected automatically) when the Restoring Wizard
is started from the Tasks menu, Recent Backups menu, or the executable backup is started.

2. In the Selecting wizard type step you can choose the restoring method. You can just
continue, or do a quick restore. Quick restore doesn't ask you any additional questions and
will place all files found in the backup to their original locations. If it is an executable backup,
you can also select to extract the zip archive from it in this step.

3. Selecting files and folders step brings up a list of files found in the backup. Here, you can
select files you would like to restore and specify the folder to where those files are extracted.
Please note - if you change the default folder path,  all "shortcuts" like Outlook Express data,
Favorites, etc. are extracted to that folder. If you want to restore "shortcuts" to their original
locations, please do not change the default path.

4. The last step is the restoring progress, where the actual restoring and file extraction work
begins. Also, you can see information about the progress and cancel the work if needed. If
some of the files already exists in the target path, you will be asked for a confirmation before
overwriting that file. On the confirmation window you can see which file (the one in a backup
or in the target path) has the latest modification date and decide which file to keep.
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4.3 Easy FTP Manager

 
Easy FTP Manager utility is added to the program so you could manage your FTP accounts.
Backups can be uploaded automatically to FTP servers (remote computers), but to download the
backup file from the server back to your computer, you need this simple utility. Or, you can use
other FTP utilities for this.
 
When you start FTP manager from the Utilities menu, a dialog appears with available connections
(1):

To manage connections, you can use the buttons at right top of connection window. When adding or
editing a connection, you can enter the information about your server:

· Host is the address of your remote FTP server. 
· Port is the port used by your FTP server (by default, 21)
· User name is the name used to connect you to the server
· Password is the password used to connect you to the server
· Folder is the default folder the program will open once you are logged in.
· Passive mode selection indicates if the servers using the passive mode or not.

Once the connection is set up and saved, select it in the list and click on the "Connect!" button at
left the toolbar. After this, you will be connected to the remote server. 

After connected, on the server panel (2) you can see folders and files of the remote computer. On
the log panel (3) you can see all the commands sent to the server. Files and folders of your local
computer are seen on the panel 4.
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To download a file from the server, select it on the server panel. Then, select the folder in your local
computer to where you would like to download that file. After selected, click the "Download selected
file" button on the toolbar. 
 
You can also upload files from your local computer to the remote computer. For this, select the file
on the local files panel (4) and click on the "Upload selected file" button. 
 
A progress bar is shown during the download and upload. On the progress panel, you can also use
the Abort button to cancel the process. 
 
To disconnect from the remote computer, click on the "Disconnect" button on the toolbar. Also, the
connection is closed when you close the FTP manager.
 
Hint: If you are connected to the server, you can right click on the server file or folder for additional
FTP server commands.
 
  

4.4 Burning Tool & Disc Management

 
With CD / DVD burning tool it is possible to write files to the CD and DVD discs. 

In addition to immediate burning after the backup is completed, you can use this tool to burn your
backups or other files later, whenever you need. To start burning utility, open Tools menu on the
main window and select Burning tool.
 

In this window you can see and use four main areas:

First is the panel "Files and folders". When it's selected, you can browse your folders and files. After
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you have located a folder, and want to burn some file from it, select that file (on panel 3) and click
"Add" button. After the button is clicked, the files is seen on the burning list (panel 4 after). In this
way you can select which files you would like to burn to your disc. If you have selected some file
you do not want to burn any more, select it in the burning list and click on the Remove button. To
remove all files from burning list, click on the "Remove all" button.
 
The second panel you can activate on this window is "Recent backups". When you select this
panel, files and folder list is replaced with list of recent backups. You can select task and any of its
recent backups. In many situations, it might be quicker way to locate backup files than by using
files and folder list.
 
As already mentioned, a panel 4 contains files list to be burned. At the bottom, you can also see the
capacity of files, free and used space on disc. In case you want to delete selected files after
successful burning, you can check the option below.

To start burning, or to use some other burning device command, click on the "Burner actions" button
at left top on this window. In the appearing menu you can see following selections:

· Burn added files and folders starts burning the selected files (burning list).

· Build ISO file will create a single archive file, containing files you selected. ISO is a common
file type in burning utilities. It allows users to prepare information for burning and keep it in one
single file while it can be burned later. 

· Open and burn ISO file command opens the prepared ISO file and burns it to the disc.

· View disc info opens information window of disc sessions and files.
· Load disc closes the open drive door.
· Eject disc opens the drive door.

· Close track protects the disc from further changes. Once you close the track, the disc can not
be modified any more.

· Quick erase is a command for rewritable discs. It will delete all the data found on the disc, so
you can start using it as a blank disc.

· Complete erase is a similar function to Quick erase, except it should be used if the rewritable
disc is brand new and is not formatted yet. 

· Device info brings up a window with information about burning device capabilities. For example
can it read and/or write CD, DVD, etc.

 
 

4.5 Windows Service Manager

 
As you might know, any program is unable to work when it's not running. Also, most programs are
unable to work when nobody is logged on to the computer. 
 
In the Professional version (only), you can use the additional utility that can start TK8 Backup as a
Windows Service. It means that when the service is started and running, the program is running even
when nobody is logged in. When you restart the computer, or log off the user, scheduled backups
are still created.
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To run the Service Utility, use the TK8 Backup group under the Windows Start button, Programs
menu. Before you run this utility, please make sure the TK8 Backup itself is closed. It's
impossible to start a service when the program itself is running. 
 
When the utility is started, you can use two simple buttons:
 

When you click on the first button, TK8 Backup is started in the service mode. To complete this
task, the utility will restart your computer. 
 
After the computer is restarted, TK8 Backup is always running in the background. Even when you
restart the Windows, and even before any user is logged on to the Windows. The program will make
all the scheduled backups silently. 
  
Please note that at the time TK8 Backup service is running, you can't start the program
(twice). It will not start. So you can't access the user interface to change program options or
task settings. 
 
Please do not terminate TK8 Backup service process manually through Task Manager as in
some cases this can corrupt your profile settings. 
 
To access the program again, you have to stop the service mode. For this, run the Service utility
again and click on the "Stop ..." button. It will shut down the service mode. After stopped, you can
close the utility and run again the program, to make any necessary changes in the options or task
settings. 
  
 

4.6 Encrypting & Decrypting a File

 
In addition to password protecting backup files, TK8 Backup is able to provide even more protection
by using strong Rijandael (AES 256) encryption algorithm (available only in the Professional version).
Backups can be encrypted right after they are created automatically, or later manually, by using
Utilities menu commands. It is possible to encrypt any file, not only backup files made by TK8
Backup

Encrypting is easy. When encryption is set in the task settings, the file is just encrypted after it is
created. To encrypt some other file, or the non-encrypted backup later, use the Tools menu and
select "Encrypt a file":
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On the encrypting window you can then select the source file you would liek to encrypt, and enter
the destination file name that is used for the encrypted content. After you have entered the password
and confirmed it, you can start the process.. 

If your file is encrypted, and you would like to open or restore it, you have to decrypt it first. It is only
possible with TK8 Backup. Again, to start the Decryption tool use the Tools menu. After the
Decryption window is opened, you can select the encrypted file and enter the file name you would
like to use for decrypted content. After you have entered the password and hit the Decrypt button,
the original content is stored from the encrypted file. You can then again access and open the
backup file. 
 
After the encryption or decryption process is done, the window is automatically closed by the
program.
 
 

5 Program Options

5.1 General

Program startup

The program can make backups only when it is running. It can run in the normal mode, system tray,
or as hidden Windows Service, but it has to run. Now - at the time your computer is turned off, the
program can not continue the work and make backups. Thus, some of the scheduled backups might
be skipped. By default, the program will automatically make backups from missed scheduled tasks,
but if you do not want this, you can disable this feature by checking the option "Do not make missed
backups on program startup".
 
To start the program automatically together with Windows startup, check the option "Start the
program on Windows startup".

If the option "Start on system tray" is checked, the program will go directly to the system tray mode
when started.

By checking "Show splash screen" option you can watch a startup screen while the program is
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loading.

Closing the program

"Minimize the program to system tray" option prevents the program from closing when it's checked.
Instead of closing, the program is switched to system tray mode. It is good in case you want to
keep the program running but are afraid you can still close it. This option is only ignored on Windows
shutdown and in case you use Exit command in the File menu. 
 
When you have backups scheduled and you close the program, it will ask if you really want to close
the program, as during the time closed, it is unable to make scheduled backups. To disable this
question from appearing each time, check the option "On closing don't notify about scheduled
backups that might be missed when the program is closed".

Other...

With "When minimizing the program, minimize to system tray" option checked, the program will go
to system tray working mode when minimized. 
 
 

5.2 Advanced

Advanced options

The program has a warning message should the target drive run out of space (based on the last
backup size). In some cases, though, the size of the last backup is indeed large, but next backups
are small enough to fit to the disk. In some systems it's not possible to know how much free space
the target drive has. In such case the rpogram wil also give a warning. It might be you are aware of
the situations described above and would like to disable the watning. For this, check the option "
Ignore "The target drive might run out of space ..." message".

Each time you change any files in your system, Windows system is activating the Archive attribute
(flag), indicating the file is not yet backed up and should be included next time. The flag is also
activated for files that are copied or moved to the new location. "Use archive attribute to detect
file changes with incremental and differential backups" is the option to indicate if you would
like to use file attributes maintained by the Windows or not. By default this option is active, meaning
the Archive attribute is used by the program when creating backups. When making incremental,
differential or inverse backups, the attribute is checked and only files with active Archive attribute are
included to the backup. After the file is included to the backup, the Archive attribute is cleared,
indicating the file has been backed up. With full backups all files are included to the backup, no
matter what the Archive attribute status is. 
 
If the Archive attribute management is disabled or not working in your system, the program can't
know if the file is changed or not, based on the Archive attribute. In such case, you can disable the
attribute usage. When the option is disabled, the program is using last backup date and file change
date to compare if the file is changed after the last backup or not and shoudl be included to the
backup or not. This method works just fine also. The only thing you have to remember is that when
you change system date and the Archive attribute usage is disable, the file might be left out from the
backup if it's changed, but you have moved back the system date. 
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If the option "Show recent backup list on the main window" is checked, you will see the list of
recent backups in the main window. If for some reason you woudl like to hide that list, just uncheck
this option.
  
By default, all folders (including hidden folders) are shown in the folder selection list (when selecting
data to back up). It is important that you won't miss any folder, even if it's hidden, when selecting
what data to back up. If for some reason you do not want to see hidden folders in the selection list,
check the option "Do not show hidden folders in the folder selection list".

If you do not want to see the system tray icon, you can check the option "Hide system tray icon".
If the program is minimized to the system tray, and its icon is hidden, the only way to bring it up, is
by using the system wide hotkey.

In the Professional version you can check the "Show backup groups" option. If active, you can set
additional group value to each backup task. This is useful when having a lot of different tasks and
you would to organize them a bit. For example, you can hide (collapse) some group from the tasks
list, back up entire group, etc. You can add additional or other columns for grouping other than the
single Group name that's used by default. For this just drag the column to the gray panel above the
list. To remove grouping, drag the columns back to the list and uncheck this option.
 
In this panel you also have the option to specify what the double-click on the task should do in the
main window. Default action is to make a backup from the task you double-click, but you can
change this action to "Edit task" and "Start backup for entire backup group".

System wide hotkey can be used to bring up the program from anywhere in your system. No
matter what other program is currently active - press this key combination on the keyboard and the
program is activated. To change the hotkey, click on the edit box and press the desired key
combination. Please note that if some other program is using the same key combination defined in
TK8 Backup, the hotkey may not work. In case the hotkey is not working, please change it. When
changing, TK8 Backup does not allow you to set hotkeys already active in your system.

Security
 
In the Professional version you can password protect program options to prevent unauthorized
changes. Also, if the program is running in the hidden mode, and system wide hotkey is pressed,
the password is required to bring it up.
 
 

5.3 Backup settings

 
Location and resources
 
Default backup folder is entered as the default destination folder when creating new tasks. To
change this folder, enter the path you would like to use or click on the button at right the edit box
and select the folder.
  
Because the backup process can use a lot of computer resources, you can set a limit of how many
backup processes can be started at once. This limit is only applied to scheduled backups. By
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default this "Autorun limit" limit is 2. Using this limit will not skip nor terminate the scheduled
backups, but will put them on hold and will run them as soon some already running backup is
completed. If you do not want to limit the number of auto started backups, set the limit to 0.
 
   

5.4 CD / DVD

 
Device used to burn backups

Drive selection indicates the device you would like to use for burning actions. If you have more than
one CD or DVD device installed, select here the one you prefer to burn your backups.

Write speed what writing speed is used to burn backups. By default (if not set otherwise), the
maximum speed is used. 
 
View device features button brings up a window with information about burning device capabilities.
For example you can see what kind of discs the device can read and/or write. 
 
Cache size is the memory buffer used on burning.
 
Joliet File System is indicating if the long file names are shortened or not when the path and name
is too long to fit to the disc. If this option is checked, long file names are supported.
 
 
Settings to burn backups

Default volume label is the name given to the disc when burning the backup.
 
Sessions selection can be used to set how the program should handle the disc when burning the
backup. If "Continue last session" is selected, new files are added to the disc and previous
information remains to the disc also. If "Start new session" is selected, the new session is started
every time when burning files and in that case no previous files will remain to the disc.
 
After burning option is the action executed once the burning is completed. "Leave disc open"
selection allows you to burn additional files to the disc in the future. "Close disc" selections will
close the disc which means no additional changes can be done on this disc. It is possible to use
different closing criterias, depending on how you would like to set up your backup system.
 
If you want or need, you can also disable automatic disc ejection after the burning is completed.
You should know, though, that in some systems the files are seen only after the disc is ejected. The
files are burned and on your disc but you will not see them until you eject and reload the disc. 
 
If you want to confirm burning starts manually every time, you can check the option "Ask
permission before the burning starts".
 
If the backup does not fit to the disc, you have the option to format it before burning (if it is a
rewritable disc). For this, check the option "Format RW disc if it has no free space available for
the backup".
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If you want to be asked for a confirmation before formatting the disc, check the option "Ask
permission before formatting the disc".
 
 

5.5 Log file

Log file settings

"Show the log after backup is completed" option allows you to view the log file automatically
every time the backup process ends. If not checked, you can still view the log file later, by using the
Tasks menu. Please note, though, that to see the log file, log file creation should be enabled for the
task. 
 
"Show the log only if error occurred" option, if checked, will show the log file automatically when
the backup is completed, but only if some error was found during the backup progress.
 
By using RTF format you can set the appearance for your log files. RTF log has color lines (for
example errors are red, headers blue etc). If RTF log option is unchecked, your log files are in the
plain text format which means you can view them also outside the TK8 Backup, by using any text
editor (for example Notepad). Log files created in the RTF format are readable from inside the TK8
Backup program.
  
  

5.6 Email

Email settings (Available in the Professional version only)
 
Before the program can email log files, you have to set up outgoing email server. Most important is
to enter your SMTP server name and port. If you want, you can change the "From" field for your
emails. Servers requiring authentication, can also be used. For this activate the authentication
option and enter the user name and password.
 
On the bottom of this options panel you will see the button to test email delivery. When you click
this button, the email settings from above are used and the sample log file is sent. You can see if
your system is able to receive such emails. If not remove the necessary mail filters.
  
 

5.7 FTP

 
On the FTP panel you can change general FTP settings. 
 
When you click the first button, "Enter FTP settings and apply to all tasks" you can enter FTP
settings. When confirmed, those settings are applied to all your tasks to perform FTP uploads for all
tasks after the backup is created. 
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The second button will do basically the same, but the settings are applied to only those tasks where
the FTP upload is currently not enabled. So if you have already set up some of the tasks, those
settings will remain the same. 
 
"Disable FTP uploading for all tasks" button will remove FTP uploading option from all tasks.
 
 

5.8 Appearance

 
List colors
 
Appearance tab allows you to change the row colors used in the main screen. For this, select which
color you would like to change and click on its edit box. After clicked, a color selection dialog
appears and you can select the color you like. After selected, the second color selection dialog
appears so you could select a matching font color also.
 
Application Language 
 
On this panel, you can select the program language you want to use in TK8 Backup. 

Language support is flexible and allows you to translate the program to any other language that is
not currently present in the list. Additionally, you can fix the texts in the current translation if you
want to. 

To fix or update the translation, click on the "Edit selected" button. That will bring up the translation
window. 
 
In case your language is not listed in the selection and you would prefer to use the translated
program, you can translate it yourself. Translating is easy and takes only few hours. To add a new
language, click on the "Create a new translation" button and enter the language name on the
appearing window. After entered, the translation window will appear.
 
When you edit the translation (or are creating a new one), a translation window appears. First step
there is to select the Window from the left panel you would like to translate (section number 1) .
After selected, you can select the value on the "Original" panel (section 2) and translate the value at
the bottom of the screen (section 3). When the sentence or word is translated, hit the Save button
and select another one you want to translate. You can also hit the Enter key on your keyboard,
which will save the translation and selects the next phrase for translation.
 
If you translate the program to your local language, please send the translation to us also, so we
could include it with next releases. To create a backup file from your translation, click on the "Back
up to desktop". After that a small file is created right to your desktop. To send it to us, attach it to
the email and send to support@tk8.com . If you translate the program to the new language, we will
give you a free license key with lifetime updates.
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5.9 Customizing the look

Adding / removing columns

After installed, TK8 Backup has a default set of columns in the tasks list. If you want to add some
columns found on the task window, but not seen on the list, open the File menu and select "
Customize Table Columns...". After selected, a customization window appears where you can see
all available columns currently not seen in the list. To add some column from the dialog, click on it
and hold down the mouse button until you drag it to the list.

To hide some columns, use the same customization window. For hiding just drag the column header
from the list to the customization box. 

After adding and removing columns is complete you can close the customization window.
 
  
To customize toolbar buttons, right-click with your mouse on the toolbar on the main window and
select 'Customize'. Or, you can use File menu and select "Customize toolbar". After that a standard
toolbar customization window appears where you can create new toolbar groups and select / remove
buttons on groups. In the command tab, you can drag available commands to existing toolbar
panels. To remove some existing button from the toolbar, click on it and drag it back to the
Commands list.
  
Column and toolbar setup is automatically saved. Next time you start TK8 Backup, your
customizations are be loaded automatically. 
 
 

6 Ordering and registration

6.1 Why to order

TK8 Backup is shareware. Shareware is try-before-you-buy software. Unlike retail software that you
buy in stores, with shareware you can try the software out and see how good it is before you buy it!
If you like it, you can order the full version. It's a great way to buy software, plus we offer the 30-day
money-back guarantee!

7 Great Reasons To Order TK8 Backup:
· Only $39.95 (US). Limited time offer: Only $29.95 (US)
· 60-day money-back guarantee
· No more trial period limitations and evaluation screens
· Free updates and upgrades for a whole year!
· Unlimited high-priority support free for lifetime
· License Key emailed to you immediately
· A warm fuzzy feeling that you did the right thing

 
Go for TK8 Backup Professional, and get more:

· All the features and benefits of TK8 Backup Standard version
· Impressive set of additional features
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· Only $59.95 (US). Limited time offer: Only $49.95 (US)
· Upgrades and updates for 2 years

 
 
Comparison of Standard and Professional Version:
 
Professional verison has all the features of Standard verison, plus:

· Encrypted backups (AES 256 real encryption is applied to backup files, instead of the

standard password protection available in the Standard version). 
· Windows Service support (that can run backup tasks even if the user is not logged in). 
· Ability to access password protected and/or disconnected network paths. 
· E-mail notifications. 
· Options to turn off computer automatically after the backup is completed. 
· Options to make backups automatically right before the computer is turned off and/or logged

off. 
· Advanced file rules (to exclude and/or include files to the backup based on their size and

last modified date). 
· Possibility to password protect task settings and program options. 
· Backup task priority settings in terms of computer resources usage. 
· Possibility to hide backup progress window. 
· Functionality to group backup tasks. 

 
 

6.2 Price

Prices are subject to change. Latest prices are listed in our homepage http://www.tk8.com. 
 
Licenses do not include a disk with the software. By purchasing a license, you will get a serial
number to register your copy (which sets you free of the 30-day trial limitation).
  
All prices listed below are in US dollars. 
 
TK8 Backup license prices:

Standard version:
Number of Users Price per User Limited time offer
1 User $39.95 $29.95
2-4 Users $32.95 $24.95
5-9 Users $29.95 $22.95
10-19 Users $26.95 $19.95
20-49 Users $23.95 $17.95
50-99 Users $20.95 $15.95
100+ Users $19.95 $14.95
Site license $2500
Country license $3500
WorldWide license $5600
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Professional version:
Number of Users Price per User Limited time offer
1 User $59.95 $49.95
2-4 Users $53.95 $44.95
5-9 Users $47.95 $39.95
10-19 Users $42.95 $35.95
20-49 Users $35.95 $29.95
50-99 Users $32.95 $27.95
100+ $29.95 $24.95
Site license $4300
Country license $6300
WorldWide license $9300
  
  
Comparison of Standard and Professional Version:
 
Professional has all the features of Standard version, plus: 

· Encrypted backups (AES 256 real encryption is applied to backup files, instead of the

standard password protection available in the Standard version). 
· Windows Service support (that can run backup tasks even if the user is not logged in). 
· Ability to access password protected and/or disconnected network paths. 
· E-mail notifications. 
· Options to turn off computer automatically after the backup is completed. 
· Options to make backups automatically right before the computer is turned off and/or logged

off. 
· Advanced file rules (to exclude and/or include files to the backup based on their size and

last modified date). 
· Possibility to password protect task settings and program options. 
· Backup task priority settings in terms of computer resources usage. 
· Possibility to hide backup progress window. 
· Functionality to group backup tasks. 

 
 

6.3 How to buy

The fastest and easiest way is to order online, using a credit card. All orders will be processed
securely in real time by SWREG (Digital River Ltd). SWREG is one of the most known processing
companies in the Internet. To offer you the best and risk-free service, we signed contract with
SWREG to process our orders.

In case you do not want to submit your credit card information online, you may use also a check,
phone, fax or purchase order. We will accept also direct wire transfers.

All our software includes unconditional 60-day money-back guarantee. If you aren't happy with
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your purchase for any reason, just let us know, and you'll receive a prompt, full refund. No questions
asked.

To start ordering, please visit our homepage http://www.tk8.com 
 
 

6.4 Entering License Key

 
Soon your order is placed, you will receive order confirmation (receipt) together with registration
information. By entering and saving this info on the registration window, your copy will be free of the
trial period limitations. 
 
The registration information contains License Owner Name and the License Key. To enter them,
please click on the "Enter License Key" link on the trial version startup screen, or use Help menu.
 
On the registration window, please enter the name and the key exactly (case sensitive) as they are
typed in the order confirmation e-mail you received. After entered, you can confirm the registration by
clicking the "Save" button. 
 
After the info is saved, the copy will be registered. Please restart the program so the registration
would take the effect.
 

7 Getting help and support

Inside the program, when you press F1 on your keyboard, you can read the help file. The help file is
also available in our homepage and in the pdf format ready for printing.
 
If you have any questions or suggestions regarding TK8 Backup, your e-mail is always welcome.

If you have any problems with the program, please include the following information when contacting
us:

·  Is the problem (error) reproducible? If so, then how?
·  What version of program are you running (to see this, use About in the Help menu)?
·  What version of Windows you are running (Windows XP, Windows 98, Windows NT 4.0, etc.)?
·  If you see a dialog box with error message on the screen then what is the full text on that

dialog box.

Official homepage: 
http://www.tk8.com

Support e-mail:
support@tk8.com
 
Support form online:
http://www.tk8.com/support.asp
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General / Sales contact:
info@tk8.com

Marketing:
marketing@tk8.com

Postal address:
TK8 Software,
B & M Konsultatsioonid Inc,
Liiva 54-A, Noo
61601 Tartumaa,
Estonia,
EU.
 
Business Phone:
+372 50 77 207 (this phone number is for sales and business contact only. To get technical support,
please e-mail us or fill the online support form)
 
 

8 Uninstalling

Removing TK8 Backup from your system is easy. 

Before starting removal close the help file and TK8 Backup program. Make sure no tasks are running
at the moment.
 
Then open the Control Panel, Add/Remove Programs window. Look for TK8 Backup in the list and
select it. Click on the "Add/Remove" button to start removing the application and follow the
instructions on the screen.
 
 

9 License agreement

TK8 Backup
LICENSE AGREEMENT

Copyright (c) 2000 - 2011 by B & M Konsultatsioonid Inc. All rights reserved.  TK8 Software is the
project of B & M Konsultatsioonid Inc. TK8 and logo for TK8 are registered trademarks.

By using, copying, transmitting, distributing or installing TK8 Backup, you agree to all of the terms of
this License.  If you do not agree to any of the terms of this License, then do not use, copy,
transmit, distribute, or install TK8 Backup.

TK8 Backup is not the free software.  Subject to the terms below, you are hereby licensed by B & M
Konsultatsioonid, Inc ("BMK") to use this software for evaluation purposes without charge for a
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period of 30 days (trial period).  

If you use this software after the 30-day evaluation period a registration fee is required. See the TK8
Backup web site at www.tk8.com for information about ordering.

Unregistered use of TK8 Backup after the 30 days is in violation of U.S. and international copyright
laws and treaties, as well as in other intellectual property laws and treaties.

You may, without making any payment to BMK:
1. Install and use shareware evaluation version of TK8 Backup free of charge for 30 days.

Subsequent downloads or installations of TK8 Backup do not extend, renew, or otherwise
restart your 30-day evaluation period.

2. Give exact copies of the shareware evaluation version of TK8 Backup personally to anyone,
except for the purpose of extending their 30-day evaluation period.

3. Distribute exact copies of the shareware evaluation version of TK8 Backup, if done
exclusively through electronic channels.

4. Make as many exact copies of the shareware evaluation version of TK8 Backup as you
wish, for purposes of distribution as described in (2) and (3) above.

YOU ARE SPECIFICALLY PROHIBITED FROM CHARGING, OR REQUESTING DONATIONS, FOR
ANY COPIES, HOWEVER MADE, AND FROM DISTRIBUTING SUCH COPIES WITH OTHER
PRODUCTS OF ANY KIND, COMMERCIAL OR OTHERWISE, WITHOUT PRIOR WRITTEN
PERMISSION FROM BMK. BMK RESERVES THE RIGHT TO REVOKE THE ABOVE
DISTRIBUTION RIGHTS AT ANY TIME, FOR ANY OR NO REASON.

THIS SOFTWARE, AND ALL ACCOMPANYING FILES, DATA AND MATERIALS, ARE
DISTRIBUTED "AS IS" AND WITH NO WARRANTIES OF ANY KIND, WHETHER EXPRESS OR
IMPLIED. THE USER MUST ASSUME THE ENTIRE RISK OF USING THIS PROGRAM.  THIS
DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THE AGREEMENT. IN
NO EVENT SHALL BMK, OR ITS PRINCIPALS, SHAREHOLDERS, OFFICERS, EMPLOYEES,
AFFILIATES, CONTRACTORS, SUBSIDIARIES, OR PARENT ORGANIZATIONS, BE LIABLE FOR
ANY INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE DAMAGES WHATSOEVER RELATING TO
THE USE OF TK8 Backup OR YOUR RELATIONSHIP WITH BMK.

IN ADDITION, IN NO EVENT DOES BMK AUTHORIZE YOU TO USE TK8 Backup IN
APPLICATIONS OR SYSTEMS WHERE TK8 Backup'S FAILURE TO PERFORM CAN
REASONABLY BE EXPECTED TO RESULT IN A SIGNIFICANT PHYSICAL INJURY, OR IN LOSS
OF LIFE.  ANY SUCH USE BY YOU IS ENTIRELY AT YOUR OWN RISK, AND YOU AGREE TO
HOLD BMK HARMLESS FROM ANY CLAIMS OR LOSSES RELATING TO SUCH UNAUTHORIZED
USE.

This Agreement is the complete statement of the Agreement between the parties on the subject
matter, and merges and supersedes all other or prior understandings, purchase orders, agreements
and arrangements. Without prejudice to any other rights, BMK may terminate this license
agreement if you fail to comply with the terms and conditions of this license agreement. In such
event, you must uninstall and destroy all copies of the TK8 Backup.

All rights of any kind in TK8 Backup which are not expressly granted in this License are entirely and
exclusively reserved to and by BMK. You may not rent, lease, modify, reverse engineer, decompile,
disassemble or create derivative works based on TK8 Backup. There are no third party beneficiaries
of any promises, obligations or representations made by BMK herein. 
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END.
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